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1. Communication Skills-II
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EXERCISE
Verbal Communication (b) Visual Communication
Os, 1s (d) Noise

Communication — Communication refers to the act of transferring information from one
place, person, or group to another by speaking, writing, or using other mediums. Every
communication process involves (at least) a sender, a message, and a recipient.

Decoding Message — Converting an encoded message into an understandable form, i.e.,
the message is converted from 0's and 1's (binary form) to a language that humans can
understand.

Feedback - Feedback is the response of the receiver after perceiving the message. It enables
the sender to evaluate the effectiveness of the message. It is like a backbone to the entire
process of communication.

Methods of communication can be categorized as follows:

Verbal Communication — This is a method of communication that involves direct interaction
and instant response. It can either be in the form of oral or written communication. It
requires a language in order to interpret ideas, views, and emotions.

Non-Verbal Communication — This is a method of communication that entails sending
and receiving messages through any of the human senses, without using language.

Some forms of non-verbal communication include gestures, body language, facial
expressions, eye contact, and posture. It is said that non-verbal communication comprises
approximately two-thirds of all communication among people and groups.

Visual Communication — Conveying ideas visually, in the form of images or pictures, is
called Visual Communication. It involves transmission and interpretation of information
through visual resources that can be read or viewed. Images, drawings, signs, graphics,
typography, etc. are some modes of visual communication.

-
Touchpad 1T-402-X (Answer Key) { 4
-+



\

]

(b)

(@]

(d

The 7C's are basic rules for efficient communication, described as follows:

Concise — One should stick to the point and keep it short. The human brain gets bored
of long and repetitive information. If the message is concise, it grabs and holds the
audience’s attention.

Concrete — The meaning of the message should be precise and firm so that audience
understands easily what the message wants to convey.

Correct — The communication should be error-free. One should always convey correct
information without misleading the audience.

Clarity — While communicating, one must be clear about the goal of the message and
the purpose of communicating with the audience.

Coherent - All points of the message should connect to each other and should remain
relevant to the main topic.

Complete — The message should be complete and should include all the relevant
information.

Courteous — The communication should be honest, respectful, and friendly.

Feedback is the backbone of the entire process of communication. It is important because:

It shows that the receiver is interactive.
It sustains the communication process.
It is a barometer for measuring the effectiveness of communication.
Positive feedback motivates an individual to do the task even better.

Negative feedback helps to improve the task and enhance the performance.

The process of communication has multiple barriers. They are:

Physical Barrier — This type of barrier refers to the interference to effective communication
occurring in the environment. It can be the distance between people, a noisy source near
a telephone, poor lighting, bad health, and other such factors.

Psychological Barrier — This type of barrier in communication distracts the communicator
or prevents them from paying attention to the message. Shrillness of voice, anxiety,
mental fatigue, and pre-conceived notions are some examples of psychological barriers
to effective communication.

Linguistic and Cultural Barriers — A language is the expression of the thoughts and
experiences of people in terms of their cultural environment. Each major region has its
own language and culture. Lack of knowledge about the local language and culture can
become a limiting factor to effective communication.

Mechanical Barrier — This type of barrier is created by the channel or medium itself.
Disturbances and interferences in the channel can prevent the flow of some of the
elements of the message from reaching their destination smoothly.
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The following measures are taken to overcome barriers in communication:

+ Eliminating the differences in perception by understanding the mentality of the receiver
before presenting views on a topic.

» Use of simple and clear words to help communicate efficiently.
 Identifying the source of noise and reducing it, or if possible, eliminating it.
« Listening attentively to avoid misunderstandings.

» Proper selection of media to ensure that the message caters to the target audience.

Declarative Sentence (b) Declarative Sentence

Exclamatory Sentence (d) Interrogative Sentence
Prepositional phrase (b) Adjective phrase

Adverb phrase (d) Noun phrase

Subject, verb, object (b) Subject, verb, object

Subject, verb, object (d) Subject, verb, object

Pronoun (b) Verb (¢) Noun
Adjective (e) Adverb (f) Interjection
an (b) ... () a

the (e) an (f) An
aa (h) The

2. Self-Management-II

(@]

(b)

EXERCISE
Yoga (b) Self-regulation
Meditation (d) self-awareness, self-motivation, self-regulation
Self-Management — Self-management is an act of committing oneself to discipline, to be

smartly organized, to be righteous and responsible, and to efficiently handle the situations
arising around oneself. Self-management includes planning, scheduling, self-development,
and continuous learning which helps in achieving the desired goals.

Stress — Stress is a normal physical and mental response to a threatening or a dangerous
situation, whether real or imagined.
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(c) Meditation - It is a way to relieve stress. It is a technique to get centered and feel peaceful
when we are carried away by stressful thoughts. Meditation involves sitting in a relaxed
position and focusing our mind on one thought for five to twenty minutes without any
distractions.

(@) Self-regulation refers to self-action or self-operation. It is one’s ability to control and
manage emotions, thoughts, behaviour and energy levels so that one can produce results
which have positive effects on life. People who are good at self-regulation can cope well
with changes and adjust to different situations easily. They consider changes to be positive
experiences and see them as exciting opportunities for self-development.

(b) One can get motivated in the following ways:

« Upon waking up in the morning, the first thing we should think is “Today I will be better
than I was yesterday, and today will be my best day”.

 Always choose to be happy. Consider every problem to be temporary.
» Try to search for the good in every situation.
+ Talk to friends and family members who motivate you.

(c) Self-awareness refers to gaining knowledge and a better understanding of ourselves. It
enables us to experience ourselves as unique and separate individuals. It is about being
honest with oneself.

Self-awareness is of two main types:
 Internal Self-Awareness
« External Self-Awareness
(d) To manage stress one can take following measures:
» Physical Exercise
* Yoga
* Meditation
« Activities that bring enjoyment
» Vacation
« Nature Walk
(e) The problems that can occur due to stress are as follows:
* Memory Loss
e Pain
» Improper diet
+ Addiction to drugs
* Quarrelsome behaviour
 Dull behaviour
» Rude behaviour

* Nervousness
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3. Information & Communication Technology-II
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EXERCIS

UNIX (b) Windows 10

File Management (d) Kernel

(i) (b) (i) @ ()
(iii) e ()

Character User Interface

Graphical User Interface

Free Software Foundation

Genuinely Not Unix

Bharat Operating System Solution

Centre for Development of Advanced Computing
Personal Digital Assistance

Personal Information Management

Plug and Play

Master Boot Record

Operating System — An operating system refers to the set of programs that provide an
interface to use the resources of the computer system effectively and efficiently. It gets
executed automatically as soon as the computer is switched ON. It coordinates the resources
of hardware, software and human ware. Examples of OS are MS-DOS, Windows, Unix, Linux,
etc.

Real Time Operating System - It is a special type of OS that processes instructions and
produces a response within a specified time. Examples: ATM, Traffic Signal, etc.

Open Source Operating System It refers to an operating system in which the programming
code is available for free. Anyone can use it and add features to it to enhance its functionality
to suit their needs. One can also re-design it and distribute or release the developed version
to others. An example is Linux Operating System.

Desktop — When a user switches on a graphical user interface OS, a graphical screen opens
up with some icons and pictures. This screen is called Desktop.

Taskbar — It is a thin, strip-like bar that lies at the bottom of the desktop screen. It is used
as a link to open and close programs and it also allows the user to access or switch between
the open applications or programs. It contains a System Tray, a Quick Launch Toolbar, and
the Start/Main menu button.
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(f) Device Driver — It refers to a form of software that enables a hardware device to be
compatible with the computer. It activates the specific hardware device that can be easily
interpreted by the CPU resources. Device drivers are OS- and hardware-dependent computer
programs, and may automatically get activated whenever that hardware device is attached
to the computer. They are provided by the device manufacturers along with the hardware
device.

(@) An operating system acts as a messenger between the computer hardware and the
application program by establishing a connection between the application and the hardware
device, such as a printer attached to a computer.

(b) CUI 0OS GUI 0S

« In CUI OS, the user sends commands | « In GUI OS, the interface is graphical, i.e.,
and instructions to the computer| the user interacts with the computer
in character form, i.e, by typing| wusing figures and graphics on the
commands at the command prompt.| screen. It is basically menu driven.
The display on the screen does not
contain any graphics.

« CUI OS is not as interactive and user |+ GUI OS is user friendly and interactive.
friendly as GUI OS.

« Examples are MS-DOS and UNIX. « Examples are Windows and Linux.

(c) Time sharing An operating system that allows the user to work on more than one application
by switching between them is called a Time Sharing OS. The switching occurs so frequently
that the user can interact with each program conveniently.

(d) Four functions of an operating system are as follows:

Device Management — OS directly controls the operation of the input-output devices, like
controlling the action of the printer, or the CD-ROM drive.

Process Management — OS handles the scheduling and synchronization of processing,
suspension and resumption of processes. OS independently prioritizes jobs for processing
inside a computer.

Memory Management — OS co-ordinates and controls the use of memory in a computer.

Security Management — OS protects information and resources against destruction and
unauthorized usage.

(e) The names of five operating systems are-
« MS-DOS
« UNIX
+ Solaris
* MS Windows

e Linux

N
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The names of five distributions of Linux operating systems are:
+ Slackware

 Solaris

« BOSS

» SUSE

* Ubuntu

Icons are buttons on desktop screens in the form of small pictures with some text written
under them. The icons represent files, folders, programs, etc. They are the minimized forms
of application packages/programs.

Some common icons present on Linux and Windows desktops are:
* Home or Computer
+ Trash or Recycle Bin

A File System helps to organize and obtain grouped information or execution from a data
storage device in a systematic manner. It is the basic structural arrangement of a set of
information with names.

Different categories of File System are:

FAT (File Allocation Table) — Used in Pen drive, Flash Drive, 9X series of Windows.
NTFS (New Technology File System) — Used in Microsoft Windows OS.

EXT (Extended File System) — Used in Linux OS.

Four points to be kept in mind while cleaning a computer are:

» Always plug out each and every cable and wire before cleaning.

* Never spray any liquid directly into the components to wipe off. Instead, spray liquid
into the cloth and then wipe the dust off.

» Use a water-diluted solvent for wiping to avoid any damage to the outer casing of
components.

» To clean your keyboard use compressed air. It removes the dust between the keys.
A computer can be protected from getting infected by a virus in the following ways:

« Download information from trusted websites. The web address of such websites starts
with ‘https’. Entrusted websites might not infect the computer system with a virus.

 Install an antivirus program. It acts as a safeguard, cleans unwanted programs, and
prevents the computer from getting infected by a virus. Antivirus programs are remedial
softwares that scan, detect, clean, and remove virus programs from a computer system.

» Scan and clean the hard disk regularly.
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4. Entrepreneurship-II
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EXERCISE
enterprise, entrepreneurship (b) philanthropists
Micro-financial (d) franchise

Myths about Entrepreneurship — There are many myths about entrepreneurship. Some
of them are as follows:

« Born Entrepreneurs — Many people assume that they are born entrepreneurs, but it is
not true. It may be in the genes but it takes self-awareness and hard work to develop
the skills.

» Huge Money - It is not necessary for an individual to invest a lot of capital to get a
business up and running.

« Instant Profit — It is not necessary that companies immediately make profits. It can take
some time and there may be many ups and downs.

» Only Young —Itis not necessary that one should be young to be a successful entrepreneur.
It has been found that older adults are more involved in entrepreneurship.

Entrepreneurship as a Career Option — Entrepreneurship is a field which is full of
uncertainties, so it is very challenging to take it up as a career. Entrepreneurs are open
minded, innovative business people who are self-motivated. An entrepreneur can be an
artist, an educator, a businessman, a service sector worker, or an inventor. Entrepreneurial
careers can be found in just about every field. New business venture creation can mean
launching a company, buying a business, taking a franchise, starting a new venture in a
family business or commercializing a technology.

Entrepreneurship is successful when the entrepreneur is creative, innovative, and uses the
resources that are available locally in the society or the country. An entrepreneur combines
various factors in a creative way in order to generate products as per the needs of customers.
It creates wealth for the self and growth for the society as the society develops with better
facilities and citizens are able to accomplish more.

Entrepreneurship and entrepreneurs plays a prominent role in life cycle of society as they
don’t only think about self-employability but also provide job opportunities for others. They
accelerate the economic growth of the society by enabling wealth creation for themselves
as well as the people who are employed in the enterprise. Entrepreneurship contributes to
finance on national scale in the form of taxation. Entrepreneurs identify the needs of the
people and society and come up with products and services to cater to them.

The following are the qualities of an entrepreneur:

* They are very clear with their targets.
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» They work hard from the beginning and work extra hours to achieve targets.

» They are courageous and are always ready to take risks.

» They are creative and innovative.

* They are problem solvers.

* They have good communication skills.

« They stay updated about the current scenario of the market.

Entrepreneurs perform various functions in a society. They are:

» Research — An entrepreneur does lot of exploration before starting a business.

» Plan — An entrepreneur identifies needs and accordingly makes plans of execution.

« Execution — After research the entrepreneur implements ideas and develops products
or services.

» Public Relations — A business requires social acceptance by the public at large. Good PR
is important in order to gain and maintain a good hold on the market.

» Marketing — Promotion and advertisement is important to make the people aware about
the existence of the products or services.

* Launch —The entrepreneur has to take initiatives to introduce their product in the market.

5. Green Skills-II

1. (a)
(@)
2. (a)

(b)

(@]

EXERCISE
Conservation (b) Wind energy
Solar panels (d) Ecosystem

Ecosystem — It is a system which consists of plants, animals, and human beings who are
dependent on each other. The relationship between living organism and their environment
forms an ecosystem and human society is the most important and integral part of this
environment.

Sustainable Development - It refers to a holistic view of economic development and usage
of natural resources that meets the needs of the present generation without finishing off
or depleting them, and saving and protecting these resources to meet the needs of future
generations.

Crop Rotation - It is the practice of planting different crops in the same farm in order to
enhance soil fertility and maintain the bind of the soil.
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Natural Environment Artificial Environment

« Natural environment consists of all | « Artificial environment is one which is
the living and non-living things. It| formed by the conversion of natural
is the interaction of all living beings,| minerals or resources by people
climate and natural resources. in the course of development in

accordance with their needs. For

example, construction of buildings,
roads, railway lines, etc.

It is healthy and enables a diverse | « It destroys ecosystem but it is required
ecosystem. by the society in which we live.

There are two types of natural resources:-
» Renewable Natural Resource — It consists of water, soil, wind, etc.
* Non-Renewable Natural Resource — It consists of coal, petrol, etc.

Sustainable development is development that meets the needs of the present generation
without finishing off or depleting the natural resources and saving and protecting these
resources for the use of future generations to meet their needs.

Itis the process or technique of collection and storage of rain water into reservoirs or tanks.
Rooftop harvesting is a kind of rain water harvesting in which the rain water does not get
wasted and is saved for use as drinking water.

6. Advanced Digital Documentation

\

]

(a)
(e)
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(b)

(@]

EXERCISE
Formatting (b) F11 (c) Cropping (d) Anchor
Bring to Front (f) Template

Character Style — There are different ways to display the style of the content of a document.
Character style is a style category that is used to apply formatting options like bold, italic,
size, and font style to characters, entire words or phrases.

Cropping — While working in a word processor document sometimes we need to insert a
definite part of an image. Cropping is a feature that is used to trim or remove what is not
required and keep only the selected part of an image.

Resizing — This is a feature in a word processor which is used to change the size of the
image. The original size of the image that is to be inserted in a document may be too big
or small for the content of the document. Resize option helps to change the image size to
the required size.
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Template - It is a layout that contains pre-defined formatting style, graphics, tables, objects,
etc. that can be used to create a document for a specific purpose. It can be used multiple
times. It saves time and effort. For example, leave application format is common for all
students of a school, so a template for leave application can be used.

Written information is the most authentic information providing system. It involves the
composition of text. When it is done manually a user may find some difficulties like:

« Editing or making a change is not possible, and if done it will make the document unclean.
 Inserting or moving text from one part to another is not possible.

» Changes in the margin settings, if required, are impossible.

» Doing spelling or grammar check is not possible.

» To search and replace a word we have to go through the document very carefully, and
there will still be a chance that a few errors don't get edited.

» No option for changing the writing style or font size.

Digital Documentation enables a user to overcome such difficulties and easily create
documents in a computer by typing text and/or inserting contents, editing them whenever
required, and saving in storage for future use, without wastage of paper.

Itis a feature in a word processor through which different levels of headings can be applied
to the entire document. For example, suppose you want to create a book having different
chapters with important topics as headings. Suppose the main heading is numbered as
1, sub-headings as 1.1, 1.2 etc., next main heading as 2, sub-headings as 2.1, 2.2 etc., and
so on. When chapters or sections are added or deleted, the numbering is automatically
changed.

It is a feature in a word processor with the help of which an automated table of contents
can be created or updated directly from the headings that are present in the document.
Whenever changes are made in the textual part of the heading in any document or the
page on which the heading appears, the changes automatically get updated in the table
of contents.

There are two types of tabs for cropping-

Keep Scale — This tab maintains or fixes the original scale of the image after cropping, so
that only the size of the image changes.

Keep Image Size — This tab maintains or fixes the original size of the image after cropping,
so that only the scale of the image changes.

Note: To reduce the scale of the image : Enter negative values in the cropping boxes.
To increase the scale of the image : Enter positive values in the cropping boxes.
There are different ways to insert an image in a document. They are-

(i) Insert a graphics or an image from a file- Using this option we can insert an image
which is already present in our system. To apply this option in a document, click on
Insert then select Picture. Click on File and then Select picture
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(i) Insertascannedimage — For this option, a scanner is connected to the system and the
image to be inserted is scanned. To do so, click on Insert then click on Picture then
click on Scan and Select Source.

(iii) Inserting graphics from a gallery via Drag-and-Drop —In this option images or objects
can be dragged from a gallery and then dropped into the document. To do so, click
on Tools and select picture from Gallery. Drag and then Drop into document

Different styles of formatting are:

(i) Character Styles — This style category is used to format single characters, entire words,
or phrases.

(i) Paragraph Styles — This style category is used to apply the same formatting such as
font, indent, layout, etc. to all the paragraphs of a document.

(iii) Frame Styles — This style category is used to format the frame's layout, position, etc.

(iv) Page Styles — This style category is used to organize the structure of the document,
i.e., page layout, page numbering, header and footer, etc.

(v)  Numbering/List Styles — This style category is used to format numbers, bullet characters,
and to specify indents.

Placement of images at appropriate locations is called ‘positioning of images'. The options
used to position an image in a word processor are:

Anchors- This option is used to position images in a document. The anchored item remains
in place or moves when we modify the document. The following anchoring options are
used to position images:

» To Page — This option enables the image to remain in the same position in relation to
the page margins and it does not move upon adding or deleting text or other images.

» To Paragraph — This option enables the image to remain in the same position in relation
to the paragraph and moves along with the paragraph.

» To Character — This option enables the graphic to be associated with a character but
not in the text sequence. It moves with the paragraph but can be placed in the margin
or another location.

» As Character — This option enables the graphic to be placed in the document like any
other character and so it affects the height of the text line and the line break.

» To Frame - If the graphic has been placed in a frame, we can anchor the graphic in a
fixed position inside the frame.

The different image arrangement techniques that are used in a word processor are:-

Bring to Front — This option places the image in front (foreground) of any other graphics
or text.

Send to Back — This option sends the image to the back (background) of the screen with
respect to other objects so that other images and text cover it.

Bring Forward — This option brings the image one layer up in the screen relative to other
objects. Depending on the number of overlapping objects, this option may be used several
times to obtain the desired result.
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Send Backward — This option works opposite to the Bring option. It sends the selected
object one layer down in the screen.

To do so:

Select the text.

Press 'F11' key.

‘Style and Formatting’ window appears on the screen.

Click the ‘Paragraph Styles' button.

A list of pre-defined paragraph styles appears in the dialogue box.

Scroll down the list and double click on the desired style. Selected style will be applied
to the text.

Click on the ‘Format’ menu.

Select the 'Styles and Formatting’ option. ‘Styles and Formatting’ window appears on
the screen.

Select the text to format.
Drag the selected text over the desired Style icon.
List of style related to it appears.

Drag the selected character or text to the ‘Style and Formatting’ window and release the
mouse button. ‘Create Style’ box appears on the screen. Write a name for the style and
click the Okay button.

Place the cursor where image is to be inserted.
Click on the ‘Insert’ menu.
Select the "Picture’ option.

Click on 'From File' option from the sub-menu. ‘Insert Picture’ window appears on the
screen.

Select the picture file and click the Insert button.

Click on 'Tools" menu and select the 'Gallery’ option.

Select the desired Picture/Graphic.

Drag the picture and drop it in the writer screen.

Click in the document where we want to insert the scanned image.

Click on 'Insert’ menu and then select ‘Picture’ option.

Choose ‘Select Source’ option from the sub-menu and then click the 'Scan’ option.
The scanned file will appear on the writer screen.

Click on the place in the document where the chart is to be inserted.

Open the spreadsheet containing the chart to be copied.

Click on 'Chart’. Drag the chart from the spreadsheet to the text document. The chart
gets inserted in the text document.
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Create a document and use different paragraph styles for different heading levels such as
‘Heading 1’ style for ‘Chapter names’ and ‘Heading 2’ and ‘Heading 3’ styles for content
headings and subheadings respectively.

Place the cursor where the table of contents is to be inserted.

Click on Insert and select Indexes and Tables. A sub-menu appears on the screen.
Type the Title and select the desired type.

Click on the 'OK’ button, and the title gets displayed on the document.

Right click the image. Hover the mouse over the ‘Arrange’ option.

Select ‘Bring to Front’ option from the sub-menu.

The selected image gets arranged on top of the graphic.

Right click on the image. Hover the mouse over the ‘Arrange’ option.

Select the 'Send backward’ option from the sub-menu.

The selected image gets arranged one level down on the screen.

7. Advanced Features of Spreadsheet

]

(a)
(©
(e)
(a)

EXERCISE
Single worksheet (b) Goal seek
Solver (d) Sheet 1, Sheet 2, Sheet 3
Hyperlinks

Data consolidation option enables a user to collect and integrate data from multiple
worksheets or workbooks into a single worksheet.

Steps to consolidate data-

.

Open the worksheets that contain the data to be consolidated.
Click the ‘Data” menu. Select ‘Consolidate’ from the sub-menu.

Click the ‘Source Data Range’ dialog box. Select the source range from the worksheet
to be consolidated and then click the 'Add’ button.

Select additional ranges from different worksheets and click the ‘Add’ button again for
each selection.

Select the desired function (Sum, Product, etc.) from the ‘Function’ box according to the
type of operation to be performed on the data.
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« Select the target cell range in which all the data are is required to be consolidated.
» Click the ‘'OK’" button. The data gets consolidated.

What-if analysis is a very useful feature in spreadsheets that helps to change cells values
to see how those changes will affect the worksheet's final outcome. One can use several
different sets of values to explore all the different results in one or more formulas. It helps to
take decisions based on the data. What-if analysis is useful in many situations. For example,
one can predict the future values based on the given historical values.

‘Link to source data’ is an option in a spreadsheet. When it is selected, the values that are
modified in the source range are automatically and accordingly updated in the target range.

The Subtotal command is used to automatically create groups and apply inbuilt functions
like Sum, Count, Average, etc. to summarize data. For example, suppose there is a worksheet
containing the list of students of a school and the students belongs to four different houses.
Now, if we want know how many students are there in each house, we can use the Subtotal
command to easily know the number of students in each house.

The ‘Goal Seek’ window components are-

» Formula Cell

« Target value

» Variable Cell

* Shrink/Maximize

There are two ways to refer to cells in other sheets-

» By entering the formula directly using the keyboard.

» By using the mouse.

Some of the benefits of sharing documents in Calc are-

* The document can be used by multiple users at the same time.

» The editing or record entering process will be faster as different users can access and
edit different areas of the same document at the same time.

The default function in the function box is ‘SUM'.

Scenario is a tool to test ‘what-if ' questions. It is a set of probable values that can be
substituted automatically in the cells of a worksheet. One of the features of scenario is
that you can create and save different groups of values on a worksheet and then switch
to any of these new scenarios to view different results. For example, using scenario one
can create a comparison chart of marks obtained by students in certain subjects, and by
changing the marks in one or more subjects, one can obtain the new average marks. One
can set targets and use this tool to determine how much more a student needs to score in
which particular subject in order to meet those targets.

Multiple Operations is a planning tool for ‘what-if ' questions, but it is different from Scenario.
A multiple operation combines a series of formulas with a variable and a series of values.
The result of each formula with each value is shown in the table. A separate set of cells give
the alternative results for the formulas used. For example, let's say ABC Company produces
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-
Touchpad 1T-402-X (Answer Key) { 15
-+



-

2N

(k)

toys that you sell for Rs. 10 each (cell B1). Each toy costs Rs. 2 to make (cell B2), in addition

to

which you have fixed costs of $10,000 per year (cell B3). How much profit will you make

in a year if you sell a particular number of toys?

In the sheet from the previous example, delete the contents of column E.

Enter the following formula in C5: =B5/B4. You are now calculating the annual profit per
item sold.

Select the range D2:F11, thus three columns.
Choose Data > Multiple Operations.

With the cursor in the Formulas field of the Multiple Operations dialog, select cells B5
through C5.

Set the cursor in the Column input cell field and click cell B4. The figure below shows
the worksheet and the Multiple Operations dialogue.

Sh

N S V— — | [ —— o i E ) F
1 10
2 2 500
Ei| 10000 1000
4 1500
s 6000 3 2000
L] 2500
L | 3000
8 3500
B | 4000
10 4500
u 5000 —_—
Multiple operations E}
Default settings
Formuas $8§5:4C55 L=
S
Colunn input cel so34]

eet and dialogue showing input

Click OK. Now the profits are listed in column E and the annual profit per item (You
might want to format column F to show 2 decimal points, for easier comparison of the
amounts.)

D2:F11 v fx & = |MULTIPLE.OPERATIONS(CSS;$8$4;$D11)
A | B | c | D ' E 1 F L

1| 10

2 2 500 -6000 -12

3 10000 1000 -2000 -2

b | 2000 1500 2000 133

5 6000 3 2000 6000 3

6 2500 10000 4

= 3000 14000 467

8 3500 18000 5.14

L | 4000 22000 55
10 4500 26000 578

1n 5000 3000

12

Results of multiple operations calculations

This feature is an important part of What-if analysis. It is basically used when the output

or

target value is fixed and we have to make a change in any one input cell value. Goal

seek option reverses the usual order of a formula. It starts with the desired result and it

cal

culates the input accordingly. For example- Suppose a student has scored 30% marks
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in an exam and the passing percentage is 33%. This student wants to increase the marks
of the sixth subject to raise the aggregate. Here, Goal Seek can be used to calculate the
minimum marks that the student should score in the sixth subject.

Solver is the descriptive form of Goal Seek. It helps with equations having multiple unknown
variables. Goal Seek is used to manipulate one input cell after fixing the target, whereas
in Solver, we can manipulate a set of cells after knowing the target value. For example,
suppose a student is aware of the marks scored in four out of six subjects. The aggregate
percentage this student needs to attain is 80%. With this as the "target value’, the Solver
tool can help the student determine the minimum marks needed in the other two subjects
to meet the target.

The steps to insert a new sheet in Calc are as follows-

» Click Insert and Select Sheet option. ‘Insert Sheet’ dialog box appears on the screen.
« Select the desired position of the sheet, i.e., position after or before the current sheet.
« Type the number of worksheets required and click the ‘OK’ button.

The steps to rename a sheet in Calc are as follows-

« Double click on one of the existing worksheet names.

« 'Rename Sheet’ dialog box appears on the screen.

« Type the desired name of the worksheet.

+ The sheet is renamed.

Syntax to create reference to an Individual Cell-

Sheet_name.Cell_address

Syntax to create reference to a Range of Cells-

Sheet_name.First_cell:Last_cell

The calculation formula for percentage in (cell B8).

B8 = B7/B5 * 100

Just enter the values given in the mentioned cells.

D4 = C4/B$5 * 100

Right click the mouse on the column header of column D. Select the ‘Delete Column’ option.
The contents of column D get deleted.

Right click the column header of column C. Select 'Insert Column’ option. A new column
gets inserted.

C8 = B6 - B7

To be filled according to user’s choice.
E4 = D4/B$5 * 100

F4 = B$5 - D4
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8. More About Spreadsheet

1.
2.

]

EXERCIS

(@) Record changes (b) Show comment (c) colors (d) comment

(@) The Record Changes feature is used to track the editing process of any cell by highlighting
it with a coloured border. On selecting the edited cell, the details of the changes made by
different authors will appear.

(b)

©

Steps to start Record Changes-

Open the document to be edited.
Click the Edit menu and Select Changes.
Select Record option.

Now start making the changes in the document. Changes get highlighted by a border
around the cells.

When you point to the highlighted cell with the mouse pointer, it can be observed that
a reference to the type of change, name of the author, date, and time, is displayed.

Comment refers to the text that gets displayed when we click the highlighted cell after
activating Record Changes. For example, information such as the cell with the previous
value and changed value, name of the user who made the change, and date and time of
change, is displayed.

Steps to add a comment are-

Select the cell in which a 'Comment’ is to be inserted.

Right click and select the 'Insert Comment’ option. Comment box will appear on the
screen.

Type the desired comment.

Click outside the box to close it. The box in which the comment has been added appears
with a coloured dot in the upper right-hand corner.

To view a comment, hover the mouse pointer over the cell that has a comment. The
comment of that cell gets displayed.

Steps to review changes are-

Open the edited worksheet.
Click the Edit menu and Select the Changes option.

Click the ‘Accept or Reject’ option from the sub-menu that appears. ‘Accept or Reject’
dialog box appears on the screen.

N
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+ According to the suggested review you have to make a decision to accept it or reject it.

Macro refers to a set of instructions/functions that can be used to automate processes that
require repetition, either frequently or within a specified time interval, in the same manner.
They are saved sequences of commands or keystrokes that are stored for later use.

Passing Argument means to pass the argument in the calling function to the corresponding
formal parameter of the called function. The called function can modify the value of the
argument by using its reference passed in.

To illustrate a function that accepts arguments, we will write a macro function that accepts
two arguments and returns the larger of the two.

Function Testmax (x,Vy
If x>=y Then
TestMax=x
Else
TestMax=y
EndIf
End Function
The steps to print comments in a spreadsheet are-
» Click on Format .
» Select Page option. Page style default dialog box appears on the screen.
+ Click on the '‘Comment’ checkbox.

» Click on the ‘OK’ button to complete setting up in order to print comments along with
the worksheet. Comments will get printed along with the worksheet.

While sharing documents, reviewers may forget to record the changes made by them in
the original document. In such a case Calc can find the changes by comparing the original
document with the edited document. To compare, the user requires the original document
as well as the edited document.

Write the formula as

=Total + 3 or =Cell address of Total marks + 3

To apply features of Record Changes to record those changes:

» Open the given worksheet to record changes.

» Click on Edit and Select the Changes option.

« Click on the 'Record’ option from the sub-menu that appears.

» Now start making changes in the spreadsheet document. The changed cells become
highlighted by a border around the cells.

+ Calc automatically adds a comment to the recorded changes that have been done along
with the author's name, date, and time of the creation of this comment in the comment
box.
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Steps to use Add Comment to display the above comments-

+ Select the cell in which ‘Comment’ is to be inserted (here, the cell with Eng written in it
first, the one with Hindi written in it next, and so on).

+ Right click and select the ‘Insert Comment’ option.
* The comment box appears on the screen. Type the desired Comment.

+ Click outside the box to close it. The new comment gets inserted.

Database Management

EXERCISE
(iii) (b) (i) (@ (i) (d (iv)
(iii) (f) (i) (9 (i) (h) (i)

E.F. Codd /IBM / 1970 (b) information

Sorting (d) key field

length (f) Length

field (h) Required or Entry required

The benefits of using DBMS are-

* Reduces Data Redundancy — DBMS reduces the duplication or repetition of data to a
large extent, thus saving valuable disk space and time.

« Sharing of Data — The data stored at one place can be used by multiple users or for
different applications. Sharing of data saves time and money. It helps in reusability.

- Ensures Data Security — It allows only authorized users to access the data from the
database. Different permissions or restrictions are imposed on a database according to
levels.

* Reduces Data Inconsistency — The data remains updated in case any change is made,
i.e., when a modification is made in one portion of data, the changes are automatically
done in the other portion wherever that data has been used.

+ Data Integrity — The DBMS ensures that only valid data can be entered into the database,
according to the standards laid down by an organization.

 Interactive Interface - DBMS provides a convenient interface for entering or viewing
data by providing a presentable format according to the user’s choice.
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The following are the elements of database-

Table — A table is a collection of logically related records. The records are arranged in a
tabular structure in the form of rows and columns. The columns represent fields and the
rows represent records.

Query -1t is a call or request to retrieve or generate some information from the tables. It
generates information according to the given conditions. It can retrieve information from
a single as well as multiple tables. It helps in managing as well as manipulating a database.

Form — It provides an interface in a user-defined layout which lets the user view, enter
records as well as modify records. Data of tables can be displayed in the form view.

Report - It displays information in a customized format as per the user's requirement.
Reports can be printed. It can present information from single as well as multiple tables.

The different types of relationships that may exist between tables are—
* Onetoone

* One to many

* Many to many

Data Redundancy means duplication or repetition of data. It means storage of the same
data in multiple places. It leads to increase in the size of the database as well as database
inconsistencies.

Data sharing means that the data stored in one place can be shared by multiple users. It
is cost-effective as well as reduces memory usage. It saves time as the table or the data is
created just once and shared among its users.

OLE object is used to insert images, pictures, graphics, finger prints, or iris patterns in a
database. If you are thinking of storing any image or graphic in any field, you can assign
the data type for that particular field as OLE.

This field property is used to enter a default value in a field. Whenever the users enter a
new record in the table, the default value gets automatically filled as the new record and
the users saves the time that would be spent on data entry in that particular field.

No, there can be only one primary key in a table. Primary key is that field of a table which
contains unique values and thus its values cannot be repeated. For example, in a STUDENT
table there can be various fields such as roll number, name, age, marks, etc. So here, roll
number can be made the primary key because other fields may contain duplicate values,
i.e., two students of a particular class can have same name as well as marks.

DBMS (Database Management System). Eg: Ms-ACCESS, Open office, org BASE.
Relationship is not established among the two tables.
Data Security and Data Integrity.
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-
Touchpad 1T-402-X (Answer Key) { 24
-+



(d) (i) The two tables that must be present in the database are Stock Table and Sales Table.

Stock Table Sales Table

Fields in Stock table Data Types Fields of Sales table Data Types
Medicine Code Text Medicine Code Text
Medicine Name Text Medicine Name Text
Manufacturer Name Text Prescribing Doctor Text
Date of Order Date/Time Patient Name Text
Date of Supply Date/Time Date of Purchase Date/Time
Date of manufacture Date/Time Date of manufacture Date/Time
Expiry Date Date/Time Expiry Date Date/Time
Quantity Numeric Quantity Numeric
Price Numeric Price Numeric

(i) The management will get the following benefits-
1. They will be well informed about the available stocks in their shops.
2. They will be pre-informed about non-availability of any particular medicine.

3. The transactions will be digital and these records can be saved and retrieved if needed. For
example, if any customer asks for a duplicate bill or makes queries about the availability
of a particular medicine, the computerized records will help.

4. End of Day Report or record about a particular period can be retrieved when needed.

10. More on Database

IEXERCISEI

1. DDL DML DCL TCL
CREATE SELECT GRANT COMMIT
ALTER UPDATE COMMENT ROLLBACK
TRUNCATE INSERT REVOKE SAVEPOINT
RENAME INTO SETTRANSACTION
DROP DELETE

2. (a) SQL (Structured Query Language).

N
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The symbols or specific characters that are used to perform arithmetical operations,
comparisons, etc. are called ‘Operators’. There are three types of operators in SQL. They
are-

 Arithmetical Operators — The operators like (+, -, *, /, % etc.) which are used to add,
subtract, multiply, divide, etc.

« Comparison Operators — The operators like (<.>,<=,! etc) which are used to compare
values in an expression.

» Logical Operators — These are operator like (All, And, Any, Between, Not, Or etc.) which
are used for performing various actions in the database such as searching for mid value,
a particular data, and combining multiple conditions in a database.

Four Logical operators are-

» ALL-It is used to compare a value to all values in another value set.

« AND - It allows the existence of multiple conditions in SQL statement.

* ANY - It compares the values in a list according to the given conditions.

« NOT - It reverses the meaning of any logical operator with which it is used.

A Table is a collection of organized data in the form of rows and columns. It is used to
represent the various relations.

For example-

Roll No Name Class Marks
101 ABC X 97
102 PQR X 96

CREATE TABLE TABLE_NAME
(
Column_Namel Data_Type (Size),
Column_Name?2 Data_Type (Size),
Column_Name3 Data_Type (Size),
Column_NameNData_Type (Size)
);
A Query is acommands that is used to define the data structure and also to manipulate the

data in the database. It is used to filter specific information from a single table or multiple
tables as per the requirement or criteria.

A 'SELECT' statement retrieves zero or more rows from one or more database tables or
database views. It has many optional clauses-

» WHERE specifies which rows to retrieve.
.
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« ORDER BY specifies an order in which to return the rows.

Syntax—

o SELECT * FROM TABLE_NAME

« Displays all the records in the table.

« SELECT * FROM TABLE-NAME WHERE (Criteria)

« Displays the records according to the mentioned criteria.

» SELECT * FROM TABLE-NAME ORDER BY FIELD_NAMEASCENDING

 Displays all the records of the mentioned table in ascending order of mentioned fields.

(a) Data Definition Language or Data Description Language is a standard for commands that
define the different structures in a database. These statements Create, Modify and Remove
database objects such as tables and indexes. Some common DDL statements are CREATE,
ALTER, RENAME, and DROP.

(b) Data Control Language command is related to security issues. It is used to control a user’s
access to a database. Some common DCL commands are GRANT, COMMENT, REVOKE.

(c) Data manipulation language enables users to retrieve, update, insert, and delete data in a
database. Common DML statements are SELECT, UPDATE, INSERT INTO, AND DELETE.

(d) Transaction Control Language is used to manage transactions by tracking other commands
and their effects on the database. It can also rollback the changes made by other commands.
Some common TCL commands are COMMIT, ROLLBACK, and SAVEPOINT.

CREATE TABLE EMPLOYEE
(

Empld char(4),
EmpName varchar(15),
Desig varchar(20),

Salary Decimal

);

CREATE TABLE STUDENT
(

Admn_No INT,

Name Varchar(25),

Age INT,

Marks INT

);

N
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Displays all the records of the table '"ACCESSORIES'.

No. Name Price ID
A01 Mother Board 12000 S01
A02 Hard Disk 5000 S01
A03 Keyboard 500 S02
A04 Mouse 300 S01
AQ5 Mother Board 13000 S02
Displays records of all those accessories whose price is greater than equal to 5000.
No. Name Price ID
A0l Mother Board 12000 S01
A02 Hard Disk 5000 S01
A05 Mother Board 13000 S02

Displays records of the table 'ACCESSORIES' in ascending (increasing) order of Price.

No. Name Price ID
A04 Mouse 300 S01
A03 Keyboard 500 S02
A02 Hard Disk 5000 So1
A0l Mother Board 12000 S01
A05 Mother Board 13000 S02

Display records from the table ACCESSORIES where Accessory name is Motherboard.

No. Name Price ID
A01 Mother Board 12000 S01
A05 Mother Board 13000 S02

Web Application

IEXERCISEI

Ease of Access (b) Topology
Domain Name System (d) Hub
Sticky Keys -1t is a feature available in graphical interfaces that enables a impaired person

to use a computer and also helps to reduce repetitive strain. It lets the user press the keys
in sequence rather than pressing it simultaneously. It helps the modifier keys to remain

\
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active until another key is pressed. The modifier keys are used in combination with other
keys to execute certain steps or actions while using a computer. Examples of sticky keys
are Shift, Function, Control, Alt, etc.

URL - URL is the unique address or location of a web page on the internet. It is used to
retrieve files on the internet. It consists of different parts. Example- http://www.abccom.
org/home/index.htm

Here,

a. httpis the Protocol name which establishes the connection with a server and sends back
the html page to the user’s browser.

b. www denotes World Wide Web.

c. Abccom.org is the domain name that denotes the web address with which it can be
searched on the internet.

d. /home/index.htm is the path and the extension that denotes the position of the file in
the server.

IM (Instant Messaging) — It refers to the exchange of messages between a sender and a
receiver instantly on the Internet. It may be text-based, or files of, audio chat, video calling,
etc. Instant messaging software may be used for personal as well as commercial use. It takes
place in real time and the response can be spontaneous and immediate if the receiver is
online. For using instant messaging feature, a user must create an 'ID’ (identity or account).
There are two kinds of instant messaging applications:-

Application Based - It is downloaded and installed on the host computer. Examples are
Google Hangouts, Yahoo! Messenger, Skype, WhatsApp, etc.

Web Based - It can be accessed by using the web browsers such as Microsoft Edge, Google
Chrome, Moxzilla Firefox, etc. Examples are Meebo, IMO, eBuddy, etc.

Web Portal - It is a web based platform that collects information from diverse resources
and displays it at one place. It is also known as public portal. Examples are AOL, MSN,
IndiaTimes, Rediff, and Yahoo! etc.

e-Governance — Use of Information Technology and various ICT tools to facilitate
government services and communication is called e-Governance. It may contain intra-
departmental communication among government departments and communication among
government agencies and citizens through government portals. Eg: online platform for tax
collection system, online land registration, etc.

e-Banking — Using banking services online without going to the bank is known as e-banking.
For eg: Money transfer (financial transaction), Downloading account statements, Updating
nominees, etc. (hon-financial transactions)

N
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Website

Web page

A website is a cluster of different
webpages addressed to certain URLs

A webpage is defined as the smaller part
of the website that includes contents
like text, media, etc. It also comprises
links to many other relevant webpages.

It requires more time for development
as compared to webpages

It requires less time for development as
it is not complex, like a website.

It is a collection of multiple pages hosted
on the server.

It is an individual hypertext document
linked under a website.

It can be accessed using a direct URL.

It can be accessed through a domain
address.

(b)

Web Browser

Web Server

Web Browser is an Application program
that displays a World wide web
document. It usually uses the internet
service to access the document.

Web server is a program or the computer
that provide services to other programs
called client.

The Web browser requests the server for
the web documents and services.

The Web server accepts, approve and
respond to the request made by the
web browser for a web document or
services.

The web browser sends an HTTP request
and gets an HTTP response.

The web server gets HTTP requests and
send HTTP responses.

(©

Wi-Fi

Wi-Max

Wi-Fi stands for wireless fidelity.

Wi-Max stand for Worldwide
Interoperability for Microwave Access.

WiFi is used for LAN (Local Area Network)
applications.

WiMax is used for MAN (Metropolitan
Area Network) applications.

Its network range is around 100 meters..

Its network can reach about 50-90 km.

WiFi connection can transmit upto 54

mbps.

WiMax connection can transmit upto 70
mbps.

(a) Four benefits of networks are-

(i)

Data Sharing — Networking enables sharing of data among computers connected across

a network.

(i) File Transfer — Users can send and receive text files, spreadsheets, presentations, and
audio and video files to other users connected to the network.
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(iii) Resource Sharing — Hardware components like printers, scanners etc., can be shared
among the users connected in a network. It is cost effective, as a single hardware device
like a printer or a scanner fulfills the requirements of multiple users.

(iv) Internet Sharing — Sharing a single internet connection among various computers
connected in a network. This type of connectivity is found in schools, internet café,
companies, etc.

Three features of WWW are-

(i) User Friendly - WWW resources are easily accessible on any internet enabled device
using a web browser.

(i) Data Sharing — WWW users can send and receive text files, spreadsheets, presentations,
and audio and video files to others.

(iii) Interactive - WWW provides graphical interface which is interactive and easy to use.
It facilitates convenient interaction between users and the server using hyperlinks and
input boxes like radio buttons, check boxes, text boxes, etc.

There are two main concepts of data transfer on the internet-

(i) Packets — Packet is a small segment of a large message. Each packet contains data
and information about the data. The packets are denoted by a 'header’, so that the
receiving machine knows what to do with the packets. The packets are then broken up
into smaller packets which are translated into bits and get routed to their destination by
devices like routers and switches. On reaching the destination end, they are recognized
by the receiving device and arranged in order to use or display.

(i) Protocols—They are set of rules or conventions to be followed while transferring data in
a network. A Protocol includes syntax, which is the format of communication between
two communicating entities. Protocols used are-

TCP : It deals with the exchange of data between two communicating entities and the
break-up of data into packets.

IP : It deals with routing and addressing data packets so that they reach the correct
destination.

HTTP : It facilitates the transfer of data between clients and servers using the request-
response approach.

E-Commerce refers to buying and selling of products and services on the internet. It reduces
the burden of establishment of shops and other additional costs. E-commerce is categorized
as-

B2B (Business to Business) — It refers to electronic transactions among business houses.

B2C (Business to Consumers) — It refers to electronic transactions among business houses
and consumers.

C2C (Consumer to Consumer) — It refers to electronic transactions among general consumers
who want to resell used goods.
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The names of four different categories of blogs are-

Personal Blogs — The most common and traditional type of a blog is a personal blog. It
may be sentimental and can be customized to be read by the blogger only. It allows the
blogger to share their thoughts and feelings with friends or others on the internet. An
example of a personal blogging website is Blogger.

Corporate Blogs — The blogs that are uploaded for business or commercial purpose are
called corporate blogs. These blogs are used by companies or organizations to enhance
internal communication . It includes feedback of customers regarding promotion of products,
brands, or public relations.

Genre Blogs — The blogs that are used for publication of articles on specific topics and
subjects are called genre blogs. One can find a variety of political blogs, travel blogs, home
decoration blogs, fashion blogs, educational blogs etc. on the internet.

Spam Blogs - Their sole purpose is to spam. A spam blog is a type of scraper site in which
the contents are either unauthentic, stolen, or copied from other websites. They are generally
unknown and obscure.

The names of Toggle keys are Num Lock, Caps Lock, and Scroll Lock.

P2P refers to Peer-to-Peer network. In such a network, all the connected computers have
equal access, rights, and responsibilities, and all the nodes or workstations have equal
capabilities.

Two types of wired connections are-

Dial-up Connection - It is a type of connectivity that uses modems and telephone lines
to connect to the internet. In this type of connection, the speed of data transfer is lesser in
comparison to broadband or DSL and the internet connectivity has to be established each
time a user switches the computer on or uses the telephone line for voice calling.

DSL/Broadband Connection — It is a type of connectivity that maintains a connection to
the internet without disturbing the telephone line. In this the data transfer rate is much
higher than a dial-up connection.

Now-a-days, optical fibers are used for providing high speed internet connections.
Two types of wireless connections are-

Wi-Fi — Wi-Fi is a network of wireless connections that can establish communication using
radio frequency like Bluetooth. It is used to connect devices like video game consoles,
home networks, mobile phones, i-Pads, i-Pods, etc. It can also connect Wi-Fi enabled PC's
or PDA's within a limited range.

Wi-Max - It stands for Worldwide Interoperability for Microwave Access. It is a type of
telecommunication technology that provides wireless transmission from multi-point links
to provide internet access to devices within a range of 50 km radius from the base station.
It provides speeds of up to 3Mbps. It lets users avail internet connections from far off
locations and enables the establishment of wireless internet networks within campuses.

Protocol refers to the set of rules which defines the standardized way of doing actions and
formatting data so that two or more devices are able to communicate and understand each
other.
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TCP/IP — TCP (Transmission Control Protocol) and IP (Internet Protocol) are two different
protocols/rules for governing the communication among computers connected to the
internet. The IP manages the movement of the packets over the internet.

It routes the data packet to its proper destination address. It also allows any computer to
further forward these packets to another computer.

TCP has to make sure that all packets reach their destinations in order/sequence and if
some packets are missing they are resent.

HTTPS — HTTP (Hyper Text Transfer Protocol) is a protocol which is used for secure data
transmissions between a web client and a web server. It is an extended version of HTTP
as it has a SSL (Secured Socket Layer) certificate. It ensures the encryption of data while
sending and decryption of data at the receiving end. It is less prone to hacking.

The following are the features of online transactions-

It is secure and convenient.

+ Itis digital so transaction details can be retrieved if required.
* Marketing and promotion methods are better.

« Itis safe as it is cashless and has payment security.

« Itis not limited to a fixed local area and has a global reach.

« Itis suitable for impulsive buyers.

The following are the characteristics of strong passwords-

» Password strength can be achieved by using different alphabets, numbers, and special
characters.

» Strong password is a combination of uppercase-lowercase alphabets.
» Keep the password of at least eight characters.
« It does not include obvious information like birthday dates, phone numbers, etc.

« Usage of special characters in a password makes it much stronger and more difficult to
guess.

Web Security & Workplace Safety

EXERCISE

Spoofing - It is the act of disguising a communication from an unknown source as being
from a known, trusted source. It is used to gain access to the personal information of the
targeted person, to spread malware by infected links or attachments, and to bypass network
access. Spoofing can be applied to e-mails, phone calls, and websites. The common spoofing
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methods are e-mail and chat spoofing.

E-Mail Spoofing — It is the process by which an attacker uses e-mail messages to trick a
recipient. The emails may include links to malicious websites or attachments.

Chat Spoofing — When a user of a computer masquerades as another individual while
engaging in chat.

Phishing - It is an attack in which communications are done in such a way that it appears
to come from an authentic source. It is usually done through e-mail. The goal is to steal
sensitive credentials or confidential personal information, and to install malware on the
victim’'s machine. Some common types of phishing attacks are Email phishing, HTTPs
phishing, and Spear phishing.

Internet security is a branch of computer science that is related to a network and web browser
security which helps to keep the data intact and safe leading to prevention of cyber-attacks.
Internet security leads to reduction of data loss, theft, and damage. It is needed at homes
as well as for business houses. It is needed when you are accessing/uploading information
online.

Five cyber threats are-
» \Virus

» Trojan Horse

» Spyware

» Spoofing

» Phishing

Spyware is a program which infects the computer and then collects information/data of the
computer without the owner’s knowledge or consent. It gets transmitted to their system
through internet, websites, webpages, and e-mails or through a network of computers. Key
logger is an example of spyware.

To prevent the attack of spyware-

» Use anti-spyware software

« Avoid exploring the error dialogues on the internet

+ Avoid using free deal offers on the internet

« Verify the authenticity of a desired program before installing it in your computer.

When malware enters a computer system certain symptoms are reflected. Some of the
symptoms are-

» Slowdown — The processing speed of the computer decreases.
» Pop-ups — Unexpected pop-ups appears on the system.

» Crash—The system crashes (stops functioning) frequently or BSOD (Blue Screen of Death)
shows up.

« Running Out of Storage Space — Malwares occupies huge storage space.

« Loss of File — Deletes useful files from the computer system.
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The following are a few tips to make strong passwords-

Good password strength can be achieved by inserting different characters into it, i.e,,
don't repeat the characters in passwords.

Avoid using the same password for multiple purposes.
It must be hard to guess but easy to remember.

You must include at least eight characters. The more the numbers of characters the
better will be the password.

Avoid using the names of loved ones, relatives, friends, nick names, etc. in passwords.
It should be a mixture of upper case and lower case letters.

It should have special symbols like-, @, #? and numbers too.

The following are the measures to prevent an electrical shock-

°

°

.

Check that cords or plugs are properly inserted in the socket/ slots in the switch board
before using any electrical appliance.

Check for faulty and improper wiring.
Disconnect machines before you service or repair them.

While repairing electrical equipment, always switch ‘OFF’ the main power supply (main
switch) of your house.

Never operate any electrical equipment with wet hands or when the equipment is wet.
Nails and staples should not be used in wires and cords.

Do not pull cords. Unplug them carefully.

Keep the wirings grounded.

Get a professional electrical safety inspection.

The common reasons of an accident are-

Accident due to fire

Accident due to a slip, trip and fall

Accident due to crash and collision

Accident due to sports activity

Accident due rash driving

Accident due to sparks or loose connection of electrical gadgets
Accident due to natural calamity

Accident due to mishandling of heavy goods

Accident due to overpressure of work

Emergency is a situation that needs immediate attention and seeks priority over anything. It
might pose a risk to life, peace, property, and health and it requires immediate management
or handling to prevent further hazards and devastating consequences.
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It may pose a threat to one's life or can cause huge damage to assets of a workplace.
Different categories of emergencies are —

» Natural Emergency -1t is a type of calamity that can occur as a result of flood, hurricanes,
tornadoes, earthquakes, forest fires, etc. Natural emergencies occur suddenly.

* Work Related Emergency — In this type, an emergency occurs at a workplace and is
related to work or its operations like chemical spills of a factory, emission of poisonous
gas, explosions, malfunctioning of machinery, electrical hazards, etc.

» Government Emergency — It is related to the government itself in case of political
instability, critical conditions at international borders, security reasons, lockdown or
curfew and it is declared by the government to handle the situation.

« External Emergency — It is a situation arising due to civil issues such as wars, protests,
strikes, and violence. Such emergencies highly affect the general masses or common
public who are in no way related to these events.

(i) Best practices for Web Security are-

« Identity Protection — It refers to safety practices to prevent theft of personal information
such as personal profile, bank account details, address details, family details.

» Protect Username and Password — A user should never save any personal or confidential
information in a computer that is used in a shared environment, such as internet cafes.

« Do not share Personal Information — Be careful while filling forms, responding to calls
that ask your name, DOB, bank details, etc.

« Secure Online Transactions — Use only secure websites for doing online transactions. A
digital certificate represented by a golden lock in the web browser’s address bar signifies
that the website is secure.

* Avoid using Insecure Wi-Fi — Never connect your device to any insecure or unknown
Wi-Fi network. Connecting to an insecure network might lead to leakage of valuable
data.

(j) Cookies are the files that are temporarily downloaded from a website and stored on the
local computer when a person visits that website. They are meant for storing the information
related to activities performed during previous browsing sessions such as login details,
details of a shopping cart, etc. and may be misused by unauthorized users who may access
the stored personal information. After completing the work refresh the operation.

(k) The following are a few fire safety measures-

* Awareness and Training — People working in any organization should be aware and
trained about the basic measures that can be taken to cope with fire especially at critical
workplaces such as power plants, mines, etc.

 Fire Drills — Mock Drills should be conducted at regular intervals so that the workers
should know what to do and where to go in case of fire.

+ Fire Safety Equipment — An organization should install and maintain certain fire safety
equipment and should know their method of use too.
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« Fire Escape Plans — A demonstration sign board displaying all the emergency exits along
with directions should be displayed at all levels.

» Restricted Smoking — An organization should prohibit smoking in its campus.

It is an uncertain incident that can happen suddenly and anywhere, be it your home,
workplace, or road, etc. It happens mainly due to a greasy and cluttered floor and causes
injury. It leads to mild cuts, bruises, etc. or sometimes can cause serious fractures or even
death. They are common and avoidable to some extent.

» The common factors that lead to falls and slips are-

» Poor visibility

« Unclean spills

» Improper floor maintenance, wet, slippery floors caused by water.

» Entangled ropes, wires, uneven cracked sidewalks, loose carpets, etc.
+ Lack of slip-resistance or friction on walking surface.

It is a well-equipped medical support kit containing some medicines, ointments, tools, and
equipment. It contains basic medical items that we should provide, in case of incidents like
injury, iliness, burns, etc. It gives temporary relief to the victim before proper or professional
medical facility is provided. A First Aid Kit must have the following things inside it-

» A heavy duty crepe bandage.

» Large clean sheet (For covering burns)
» Thermal blanket (for treating shock)

« String relief cream, gel, or spray

* Hydro gel, Hydro gel dressings

+ Clean polythene sheets

« Cotton bandage

A hazard is defined as an object, situation or behavior that has the potential to cause
physical and mental harm to a person.

There are various kinds of occupational hazards i.e the risks that are intentionally or
unintentionally accepted as a consequence of your nature of work or workplace.

Few are explained over here:

1. Electrical Hazards — Improper wiring, trailing cords running across floor, exposed wires
etc. can cause electric current/shocks which can be hazardous.

2. Machine-related Hazards — Working with unguarded and moving machinery parts can
cause accidents and cause injury, and such situations are also hazardous.

3. Biological Hazards — Exposure to fungi, bacteria, viruses, insect bites etc. is hazardous.

4. Physical Hazards — There are certain abstract hazards at some workplaces that can harm
the body without even touching it, like- radiation, exposure to sunlight/ultraviolet rays,
temperature extremes-hot and cold, noise pollution.
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5. Chemical Hazards — It occurs in situations when a worker is exposed to gas, vapours, or
chemicals that are used in articles like cleaning products, paints, acids, solvents, gases
like acetylene, propane, carbon monoxide and helium, flammable materials like gasoline,
explosive chemicals etc., and pesticides.

6. Ergonomic Hazards-The factors that causes harm to your musculoskeletal system such
as poor posture, frequent lifting, improperly adjusted chairs and workstations, etc.

Evacuation refers to the act of emptying or escaping from a dangerous location (i.e which
has got a possible threat) to a safe and secure location.

« Organizations must have a well prepared evacuation plan. It should be prepared
considering the needs and nature of each employee. Each person should have a personal
evacuation procedure ready according to workplace location.

+ Special assistance and priority should be given to physically challenged people while
evacuating the premises.

» Smoke detectors and fire extinguishers should be installed in each floor and regularly
checked and maintained to evaluate their condition.

« Evacuation drills must be organized at regular intervals and employees should follow
the instructions carefully.

» The emergency exits should be known to each person working in that office.They should
be clear and unobstructed.

» Fire alarms should be installed.
» Emergency procedures and exits should be indicated clearly.

The websites that follow the protocol ‘https’ are secured for data transmissions. A digital
certificate represented by a golden lock in the web browser’s address bar also signifies that
the website is secure.

The steps to handle accidents are as follows-

« Assure first aid and call for emergency services.

« Control secondary accidents by awareness and presence of mind.

» Preserve physical evidence and try to secure the scene so that it is not altered or removed.
* Notify the owner or the upper management about the accident.

+ Contact the families of the victims as well as the insurance company or other necessary
regulatory agencies.

A Firewall is either a software or hardware that helps to keep a network secure. It analyzes
the network traffic and determines whether the traffic should be allowed or not in the
network. It provides an additional layer of security to the computer.

It is a combination of various character codes that is used to protect the valuable content
(documents, files etc.) from unauthorized access. It provides additional security to our
important and confidential files, accounts, etc. One can access a file only if the correct
password is entered. A password consists of alphabets, numbers and special symbols .Usage
of special characters makes a password very strong.
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Spam refers to unwanted messages that are received in the inbox of a person. The spammer
sends such mails with an intention to advertise products and services.

Trojan horses are infectious programs that silently infect the computer and corrupt the
files of a host computer. They enter into our computer’s system via computer games, fake
websites, emails, etc. They don't replicate themselves but remain active inside the host
computer making it easy for cyber criminals to steal confidential data from the system.
They are also termed as ‘Backdoor’ as they intrude into the system when the main user or
owner of the system is busy working on any other app.

To protect your system from such attacks, it is advisable not to open spams, e-mail
attachments or files sent from an unknown source or website. Examples — Rootkit Trojan
Infostealer, Trojan IM, etc.

It stands for Man in the Middle attack. It requires three persons or entities, i.e., victim,
person interacting with the victim, and an attacker who is in the middle of this cycle whose
main intention is to insert himself into this communication to steal information from the
conversation or confidential data such as passwords, login credentials, etc.

The common entry points are an open or less secured public network or Wi fi spot.
To avoid this kind of attack:

» One should try not to access any less secured network

» Use updated antivirus

« Try to keep a strong password even for your home network and other smart devices
accessing that network preventing unauthorized intrusion.
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